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Uvod 
 
WINDOWS 95 je novija verzija operativnog sistema ameri~kog 

proizvo|a~a Microsoft namenjena personalnim ra~unarima sa IBM PC 
arhitekturom i procesorom Intel 80386 ili novijim. Radi se o specijalnom 
programu koji obezbe|uje osnovne funkcije upravljanja ra~unarskim 
komponentama i pod ~ijom kontrolom se izvr{avaju svi drugi korisni~ki 
programi namenjeni raznim potrebama (aplikacije). 

Obzirom da operativni sistem upravlja funkcionisanjem ra~unara, 
stvara potrebnu radnu okolinu za sve ostale programe i ostvaruje vezu izme|u 
ra~unara i korisnika prijemom komandi i prikazivanjem rezultata rada, 
poznavanje njegove upotrebe je do presudnog zna~aja za potpuno 
iskori{}avanje mogu}nosti ra~unara. Ovladavanje operativnim sistemom treba 
da bude prvi korak u obuci za rad na ra~unarima i temelj svih kasnijih 
saznanja vezanih za specifi~ne oblasti njihove primene u svakodnevnim 
poslovima. 

Osnovna uloga operativnog sistema je da bude prevodilac izme|u 
~oveka i ma{ine, {to razumljiviji prema ~oveku, a {to efikasniji prema spletu 
digitalne elektronike i precizne mehanike koja sa~injava ra~unar. Dizajneri su 
novim izgledom poku{ali da re{e zadatak {to prirodnijeg predstavljanja 
ra~unarskih resursda korisniku na jednostavan na~in. Re{enje koje je 
ponu}eno predstavlja rezultat obimnih istra`ivanja i ispitivanja velikog broja 
uzoraka iz raznovrsnih ciljnih grupa korisnika. 

 
Prvi Windows koraci 

 
Osnovni izgled ekrana 
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Ekran je u WINDOWS 95 podeljen na dva osnovna dela. Najve}i deo 
predstavlja radnu povr{inu (Desktop) na kojoj se odvijaju sve aktivnosti 
programa. Drugi deo je mnogo manji i nalazi se na dnu ekrana. On se zove 
Taskbar i predstavlja liniju sa koje se pokre}u aplikacije, prelazi iz jedne u 
drugu, prikazuje status rada i drugo. 

 
Radna povr{ina (Desktop) 
 
Desktop je osnovna radna povr{ina na kojoj se odvijaju sve aktivnosti 

aplikacija. Mo`e se posmatrati kao obi~na pozadina svih ostalih objekata na 
ekranu, ali desktop predstavlja mnogo vi{e od toga. To je objekat sa svojim 
osobinama, koje se mogu prilago|avati potrebama i na sebi mo`e “dr`ati” 
razne druge objekte u obliku njihovih grafi~kih simbola, ikona ili otvorenih 
prozora u kojima se zadaju komande aplikacije i ispisuju rezultati njenog rada. 

Objekti koji se mogu na}i na desktop-u su ikone aplikacija (ili njihovi 
prozori kada su aktivne), datoteka, kataloga (folders), zatim pokaziva~i na 
njih, pokaziva~i na ure|aje , mre`e i drugi. Me|utim, na desktop-u se obi~no 
~uvaju samo objekti koji se naj~e{}e koriste. U ra~unaru mo`e biti na stotine 
programa i datoteka, pa bi desktop bio nepregledan ako bi sve stavljali na 
njega. Uostalom, nikada ne dr`imo na stolu sav kancelarijski materjal, ve} 
pone{to odlo`imo i u fioke dok nam ne zatreba. 

 
Komandna linija (Taskbar) 
 
Taskbar se mo`e posmatrati kao centralna komandna tabla sa koje se 

pokre}u aplikacije, prelazi iz jedne u drugu, dobija status rada i sli~no. 
Inicijalno se nalazi na dnu ekrana i uvek je vidljiv, jer se postavlja iznad svih 
aktivnih prozora i aplikacija, mada se njegov polo`aj, veli~ina i druge osobine 
mogu po potrebi promeniti. 

Taskbar se sastoji od tri osnovna segmenta. U levom uglu je dugme 
Start preko koga se pokre}u sve instalirane aplikacije i zadaju razne sistemske 
komande. U desnom uglu se statusno polje (notification area)  preko koga se 
prati stanje sistema, odnosno raznih programa koji se izvr{avaju u pozadini, 
bez otvaranja prozora i dugmeta na taskbar-u. Tu se mo`e nalaziti ~asovnik, 
komanda za pode{avanje ja~ine zvuka (sli~ica zvu~nika), komanda za 
pra}enje toka {tampanja (sli~ica {tampa~a koja se pojavi kada je {tampanje u 
toku), tok modemske ili faks veze (sli~ica modema), simbol za izbor aktivnog 
tastaturnog rasporeda ukoliko je instalirano vi{e njih itd. Ako par sekundi 
zadr`ite pokaziva~ iznad ovi sli~ica, dobi}ete dodatne informacije, a 
dvostrukim klikom se pokre}e aplikacija za upravljanje njihovim radom. 

Centralni deo taskbar-a rezervisan je za dugmad trenutno aktivnihg 
aplikacija. Pri pokretanju aplikacija ovde se pojavljuju njihovi grafi~ki simboli u 
obliku dugmeta (tastera), {to omogu}ava da se na jednom mestu prate svi 
pokrenuti programi i da se jednostavnim pritiskom na dugme nekog od njih 
izabere ona sa kojom se trenutno radi. Ovaj deo taskbar-a se , dakle, mo`e 
posmatrati kao bira~ kanala na televizoru. 

 
Na~in rada pod WINDOWS 95 
 
Osnovna ideja operartivnih sistema koji su grafi~ki orijentisani je {to 

prirodnija upotreba ra~unara. Glavni cilj je koristiti kompjuter na vizuelno jasan 
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na~in, slede}i logiku upotrebe raznih drugih predmeta i alatki iz svakodnevnog 
`ivota. Komande koje korisnik upu}uje ra~unaru treba da se unose na 
“pokaziva~ki” na~in koji se koristi i u stvarnom svetu. Zbog toga je izmi{ljen 
mi{, jednostavni pokaziva~ki ure|aj na kome je zasnovan dobar deo 
upravljanja Windows operativnim sistemom. Drugi uredjaj koji se koristi za 
komandovanje je tastatura, neophodna za uno{enje tekstova, brojnih 
podataka i sli~no. 

 
Upotreba mi{a 
 
Osnovni zahvati koji se izvode mi{em su: 
- pomeranje pokaziva~a: pokaziva~ mi{a je na ekranu prikazan u obliku 

strelice i slu`i operativnom sistemu kao indikacija objekta na koji korisnik `eli 
da primeni neku akciju. 

-izbor objekata ili klik levim tasterom: izvodi se kratkim pritiskom i 
otpu{tanjem levog tastera mi{a. Ova akcija deluje isklju~ivo na objekat iznad 
koga se trenutno nalazi pokaziva~. 

-alternativna akcija ili klik desnim tasterom: Ovom akcijom obi~no 
ispisujete pomo}ne liste komandi za objekat na kome se trenutno nalazi 
pokaziva~, pa se naziva dugmetom za meni objekta. 

-aktiviranje objekta ili dvostruki klik: levi taster mi{a se pritisne dva puta 
uz vrlo malu pauzu izme|u. Slu`i za aktiviranje akcija predstavljenih u obliku 
ikone. Dakle, jedan klik na ikonu je obi~no dovodi u fokus, a klik-klik pokre}e 
akciju koju doti~na sli~ica simbolizuje. 

-prevla~enje objekta: pokaziva~ se dovede na objekat, pritisne se (i ne 
pu{ta!) levi taster i pri tome se pomera mi{. Pokaziva~ na ekranu onda sa 
sobom “nosi” izabrani objekat, sve dok se taster ne pusti, kada se objekat 
odvoji od pokaziva~a i “padne” na desktop. Korisiti se za preme{tanje 
objekata. 

 
Upotreba tastature 
 
Ra~unarska tastatura se koristi na sli~an na~in kao pisa}a ma{ina. 

Me|utim, ona sadr`i vi{e specijalnih tastera: 
- funkcijski tasteri F1-...-F12 - oni su programabilni, svaka aplikacija ih 

koristi za sopstvene potrebe. Obi~no F1 se koristi za pozivanje sistema za 
davanje uputstva u radu, tzv. help. 

- Esc- ovaj taster se nalazi u gornjem levom uglu tastature i naj~e{}e 
ozna~ava odustajanje od zapo~ete operacije. 

- Enter- taster za prelazak u novi red pri kucanju, a u komandnom 
modu se koristi za potvrdu zadate ili izabrane naredbe. 

- Strelice - kursorski tasteri kojima se kontroli{e kretanje pokaziva~a 
(cursor). 

-Shift,Ctrl i Alt - ova tri specijalizovana tastera pro{iruju mogu}nosti 
tastature. Pritisak na njih modifikuje dejstvo ostalih tastera. 

 
Pokretanje programa 
 
Dugme Start u levom donjem uglu ekrana slu`i za pokretanje 

instaliranih aplikacija i aktiviranje sistemskih komandi. Dovedemo pokaziva~ 
mi{a na to dugme i pritisnemo levi taster. Kao rezultat pojavi}e se lista 
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komandi odnosno meni. Sada iz menija treba izabrati neku stavku ili odustati 
od izbora. Odustajanje se vr{i tako {to kliknemo mi{em negde na praznom 
prostoru desktop-a, ili pritiskom na taster Esc.  

Ako dovedemo pokaziva~ na stavku Programs Start menija, posle par 
sekundi pojavljuje se nova lista. Sadr`aj dobijene podliste zavisi od instaliranih 
programa. Ako 
izaberemo stavku 
Accessories i 
pojavljuje se tre}a 
lista koja sadr`i same 
programe. Dovedemo 
pokaziva~ do 
programa WordPad i 
kliknemo levim 
tasterom. Upravo 
smo pokrenuli 
program WordPad 
pod WINDOWS 95 
operativnim 
sistemom. 

Pritiskom na 
kombinaciju tastera Ctrl+Esc aktivira se Start meni ( {to je alternativa pritisku 
mi{em na Start dugme). Kori{}enjem kursorskih strelica, i Enter tastera 
kre}emo kroz liste i podliste Start menija. 

 
Osnovni elementi prozora 
 
Windows je operativni sistem u kome se istovremeno mo`e pokrenuti 

vi{e programa (multitasking). Svaka aplikacija dobija svoj pravougaoni prostor 
na ekranu koji se naziva prozor (window). Veli~inu i polo`aj tog prozora 
korisnik slobodno pode{ava. 

Va`na osobina Windows-a je i jednobraznost svih aplikacija koje se pod 
njim startuju. Zbog toga }ete, po{to ovladate upotrebom jednog programa, vrlo 
lako koristiti i svaki drugi,uz malo poznavanje engleskog jezika i prou~avanje 
specifi~nosti date aplikacije. 

Svaki prozor ima naslovnu liniju (title bar) sa nazivom aplikacije 
(caption) koja se u njemu izvr{ava.Hvatanjem naslova uz pomo} kursora mi{a i 
njegovim prevla~enjem ~itav program se pomera po ekranu. Ivice prozora 
imaju posebnu ulogu: njihovim prevla~enjem se menjaju dimenzije standarnih 
prozora.Dovedite pokaziva~ na neku od horizontalnih ili vertikalnih ivica, 
njegov oblik }e se promeniti u dvostrane strelice, koje pokazuju smer mogu}eg 
prevla~enja. Ukoliko se u tom polo`aju pritisne levi taster mi{a i mi{ pomera, 
izabrana ivica prati smer pomeranja. Otpu{tanjem tastera prozor se skalira na 
novu veli~inu. Uglovi prozora, kao spojevi dve ivice, omogu}avaju da se 
dimenzija prozora istovremeno menjaju i po horizontali i po vertikali. 

Tri dugmeta u gornjem desnom uglu prozora imaju specijalnu namenu. 
Klik mi{em na prvo dugme sleva umanjuje prozor, a prisustvo aplikacije 
ozna~ava se dugmetom na taskbar-u. Klik na to dugme vrati}e prozoru 
njegovu prvobitnu poziciju i dimenzije. 
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Srednje dugme u desnom gornjem uglu prozora uve}ava prozor na sav 
raspolo`iv prostor na ekranu. Ponovni pritisak na isto dugme vra}a prozor na 
iste dimenzije. 

Tre}e dugme , na kome je stilizovano “X”, slu`i za zatvaranje aplikacije i 
time se prekida dalji rad sa tim programom. 

U levom gornjem uglu prozora nalazi se grafi~ki simbol aplikacije koja 
se u njemu izvr{ava. Klikom na taj simbol dobija se lista sa komandama koje 
smo upravo opisali. Restore vra}a dimenzije prozora na po~etne, Move 
preme{ta prozor na novu lokaciju, Size menja dimenzije prozora, Minimize 
minimizira prozor, Maximize ga uve}ava na celu povr{inu desktop-a, dok se 
izborom komande Close zatvara aplikacija i time zavr{ava njeno izvr{avanje. 

Kod Windows-a se ista stvar obi~no mo`e posti}i na vi{e razli~itih 
na~ina, pa su tako i sve opisane operacije pristupa~ne i preko tastature. 

Da  bismo objasnili osnove rada sa WINDOWS 95 programom, 
startova}emo program WordPad (u Start meniju aktiviramo stavku Programs, 
zatim u otvorenoj listi stavku Accessories i na kraju u novootvorenoj listi  
stavku WordPad).  Centralni deo aplikacije zauzima radni prostor (application 
workspaces) u kome se unose podaci. Kod programa za obradu teksta, na 
primer, radni prostor sadr`i sam tekst koji se unosi (unesite nekoliko re~enica 
u pokrenuti WordPad). Tekst se pojavljuje na mestu kursora koji ima oblik 
vertikalne trep}u}e crtice. Dokument mo`e biti mnogo ve}i od prozora u kome 
se unosi. Za pregled celog dokumenta koriste se kliza~i (scroll bars) uz donju 
i desnu ivicu prozora. 

Meniji su pregledno organizovane liste komandi koje se u datom 
trenutku mogu izabrati. U svim Windows aplikacijama ispod naslovne linije 
prozora nalazi se linija sa listama komandi. Liste  se otvaraju klikom na neki 
od naziva u meniju. Komande ispisane ble|im slovom u datoj situaciji se ne 
mogu aktivirati. Pojedine stavke mogu biti nazivi novih lista komandi, koje se 
dalje mogu otvarati kaskadno- prepozanaju se po maloj strelici desno od 
naziva. Neke komande u listi su prekida~i koji mogu biti uklju~eni (checked) 
{to se ozna~ava “{triklom” ili isklju~eni(unchecked). 

Dobar deo komandnih listi (menija) karakteri{e ve}inu aplikacija, pa je 
snala`enje olak{ano. 

U nazivima lista i samih komandi uvek postoji po jedno podvu~eno 
slovo, na osnovu koga se ta komanda bira sa tastature. Uz pritisak taster Alt 
otkuca se neko od podvu~enih slova u meniju, ~ime se otvara lista sa tim 
nazivom. 

Pojedine komande izvr{avaju se jako ~esto, pa nije racionalno tra`iti ih 
po menijima i listama. Zbog toga je ostavljena mogu}nost upotrebe kontrolne 
table sa dugmi}ima, koja se postavi ispod menija: pritisak na dugme direktno 
poziva naredbu ~iji je stilizovani grafi~ki simbol na njemu nacrtan. 

U mno{tvu grafi~kih simbola ~esto nije lako pogoditi {ta koji od njih 
ozna~ava- najzad, neki simbol ne mora vas asocirati na ono na {ta je asocirao 
autora programa. Zbog toga aplikacije pisane za WINDOWS 95 podr`avaju  
prikaz kratkih napomena (tooltip) koje se pojave ako pokaziva~ mi{a stoji par 
sekundi iznad nekog objekta (npr. dugmeta), bez klika.  

Naziv komande nije uvek dovoljan da korisnik zaklju~i ~emu ona slu`i, 
pogotovu ako tek ovladava novim programom. Dodatnu pomo} pru`a linija za 
poruke (message bar) koja se nalazi na dnu prozora ve}ine aplikacija. Kada 
se pokaziva~ mi{a zadr`i iznad nekog dugmeta na toolbar-u, ne}e se samo 
pojaviti tooltip prozor~i} ve} i re~enica u statusnoj liniji koja }e pojasniti ulogu 
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doti~nog tastera. Sli~no va`i i za {etnju kroz menije - statusna linija, poput 
vodi~a, obja{njava ~emu trenutno izabrana komanda slu`i. 

Najpotrebnije komande se obi~no mogu zadavati i sa tastature, 
kori{}enjem kombinacije tastera koja se zove hot key. U te svrhe se obi~no 
koriste funkcijski tasteri ili slova u kombinaciji sa Ctrl ili Alt modifikatorima. Ove 
kombinacije su u menijima nazna~ene desno od imena pridru`ene komande. 

 
Dijalog prozori 
 
Ve}ina aplikacija se izvr{ava u jednom prozoru, ali za potrebe raznih 

unosa podataka koriste se i dodatni dijalog prozori. U nekim slu~ajevima to }e 
biti op{ti dijalog prozori koje kontroli{e sam WINDOWS 95 (izbor datoteke, 
pode{avanja {tampa~a, liste osobina objektat...), {to zna~i da se poslovi iz 
svih aplikacija obavljaju na isti na~in. Postoje, naravno, i dijalog prozori 
specifi~ni za konkretne aplikacije. 

 
Nazivi datoteka 
 
Naziv datoteke se sastoji iz dva segmenta razdvojena ta~kom. Prvi deo 

je samo ime, a iza ta~ke se nalazi tzv. ekstenzija koja se mo`e posmatrati kao 
prezime ili tip. Tip odre|uje vrstu dokumenta i naj~e{}e se sastoji od tri slova: 
svi doklumenti treba da imaju ekstenziju .DOC, programi se prepoznaju po 
.EXE, slike po .BMP ili .PCX itd. Naziv datoteke mo`e biti dug do 255 
karaktera i mo`e se sastojati od slova, razmaka i nekih specijalnih simbola 
(!@#$%^&`’~{}[]+=;) , mada specijalne simbole treba izbegavati. U nazivima 
se razlikuju velika i mala slova. 

 
Rad sa vi{e prozora 
 
WINDOWS 95, kao {to smo videli, omogu}ava istovremeno pokretanje 

vi{e aplikacija, od kojih svaka mo`e otvoriti jedan ili vi{e prozora.  
Pokrenimo nekoliko programa: komandom Start->Programs-

>Accessories->WordPad aktiviramo WordPad, zatim sa Start->Programs-
>Accessories->Paint pokrenemo program za crtanje Paint i najzad sa Start-
>Programs->Accessories->Games->Free Cell pokrenemo igru sa kartama. 
Prozori sve tri startovane aplikacije nalaze se istovremeno otvoreni na 
desktop-u i delimi~mo (ili potpuno) se pokrivaju, poput razbacanih listova 
papira po stolu. Uvek se samo jedna “nalazi u fokusu” i ona prima komande 
koje trenutno upu}uje korisnik. Aplikacija koja je trenutno u fokusu i na koju se 
odnose sve komande sa tastature ima promenjenu boju naslovne linije 
prozora, a njeno dugme na taskbar liniji je “pritisnuto”.  

Dovo|enje prozora u fokus se posti`e na vi{e na~ina , a osnovni su: 
- klik mi{em na dugme `eljene aplikacije u taskbar delu. 
- dr`anjem tastera Alt i pritiskanjem Tab-a prebacuje se fokus izme|u 

svih aktivnih aplikacija, uz mali dijalog sa njihovim simbolima koji se tom 
prilikom pojavi. 

-klik mi{em na bilo koji vidljivi deo prozora (ako prozor nije potpuno 
zaklonjen). 

Prozori mogu da se raspore|uju ru~no, na na~in koji smo ve} opisali, ili 
se mo`e narediti njihovo automatsko slaganje (window arrange). Klikom 



 10

desnim tasterom mi{a na prazan deo taskbar linije u dnu ekrana dobija se lista 
komandi. 

Naredbom Cascade svi otvoreni prozori se preurede tako {to se 
kaskadno pore|aju jedan iza drugog. Tile Horizontally }e preslo`iti prozore tako 
da se rasporede po horizontali jedan do drugog, dok }e ih Tile Vertically slo`iti 
po vertikali. Najzad, Minimize All Windows }e sve otvorene prozore 
minimizovati. Prethodno izveden zahvat nad prozorima mo`e da se poni{ti 
Undo komandom. 

 
Izlazak iz Windows-a 
 

Operativni sistemi namenjeni izvr{avanju vi{e aplikacija i procesa istovremeno 
zahtevaju propisnu proceduru isklju~ivanja ra~unara. Za razliku od DOS-a , 
pod WINDOWS 95 se ne sme jednostavno ugasiti ili resetovati ra~unar!  

 
Propisana procedura regularnog 

izlaska iz WINDOWS 95 je : Start->Shut 
Down... sa Taskbar komandne linije. 
Postoje ~etiri na~ina za izlazak iz 
WINDOWS 95:  

- Shut down the computer izvodi 
pripremu za isklju~ivanje ra~unara. Va`no 
je da se to uradi na kraju rada. 

- Restart the computer izvodi restartovanje, odnosno obaranje 
operativnog sistema i njegovo ponovo startovanje sa diska. 

- Restart the computer in MS-DOS mode izaziva prelaz iz grafi~kog 
okru`enja u DOS mod, tekst okolinu koja veoma li~i na prethodne verzije 
DOS-a. 

-Close all programs and log on as a different user tako|e vr{i restart 
operativnog sistema, uz mogu}nost prijavljivanja drugog korisnika za rad na 
mre`i. 

Po{to se izabere jedna od ~etiri ponu|ene opcije i klikne na dugme Yes, 
po~inje Shut Down procedura koja najpre proziva sve aktivne aplikacije i 
upu}uje im zahtev da zavr{e sa radom i uklone se. Ukoliko neka od njih 
zahteva intervenciju korisnika pre isklju~enja (recimo postoje podaci koji nisu 
snimljeni), bi}e prikazan odgovaraju}i dijalog. 

Kada se pojavi poruka It’s now safe to turn off your computer, ra~unar 
se mo`e bezbedno isklju~iti. 

 
 
 
 
 
Help sistem 
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Jedan od najja~ih WINDOWS 95 oru`ja je mo}an sistem za pru`anje 
pomo}i korisniku (help). Sistem za pomo} se sastoji od integrisanih baza 
podataka sa uputstvima na razne teme i aplikacije koja upravlja prikazom 
help-a i obezbe}uje da se u svakom trenutku dojie odgovaraju}a pomo}. 

Windows 
help sistem je 
hipertekstualan. To 
zna~i da su teme 
unutar help-a 
me|usobno 
povezane, tako da 
upu}uju jedna na 
drugu, a korisnik 
bira redosled 
ispisivanja 
obja{njenja. 

Generalno , 
sistem za pomo} 
se poziva preko 
Start->Help 
komande sa 
taskbar-a . 
Pojavljuje se 
prozor sa op{tom 
listom sadr`aja uputstva. Da bi se pre{lo na detaljnije teme, treba odabrati neki 
od naslova iz liste dvostrukim klikom mi{a ili dovo|enjem kurzota i pritiskom na 
Enter. Time se tema “otvara”, {to simbolizuje otvaranje stilizovane knji`ice uz 
naziv teme. 

Tema mo`e imati nove podteme (knji`ice), i tako dok se ne do}e do 
konkretnog odgovora na konkretna pitanja(listovi sa upitnikom). 

Za re~i podvu~ene isprekidanom linijom mo`e se dobiti poja{njenje 
preko malog pop-up prozora koji se pojavi kada se na njih klikne (pokaziva~ 
iznad ovakvih re~i menja oblik u “ruku”). Treba zapaziti i dugme Related 
Topics u dnu prozora sa obja{njenjem. Klikom na njega se dobija lista srodnih 
tema iz koje se mo`e i}i dalje u pretra`ivanje. 

U vrhu prozora sa obja{njenjima nalaze se komande za dobijanje 
osnovne liste tema (Help Topics), povratak na prethodno obja{njenje (Back) i 
pode{avanje opcija (Options), gde se mogu izabrati slova za ispis ili narediti 
da prozor sa uputstvima uvek bude ispred ostalih (Keep Help on Top). 
Obja{njenje se tako|e mo`e iskopirati (Copy) na Clipboard (o njemu kasnije) ili 
od{tampati (Print), a mogu se dodati i sopstvene bele{ke (Annotate). 

 
Pomo} u aplikacijama 
 
Pored op{teg helpa na nivou operativnog sistema, skoro svaka 

aplikacija ima i sopstveni sistem davanja uputstva za rad u njoj. Ovaj sistem 
se poziva iz menija , preko liste Help koja se nalazi na desnoj strani menu bar 
linije. Izborom Help Topics , Contents ili sli~ne komande iz ove liste dobija se 
sadr`aj aplikativnog uputstva. Na~in upotrebe je potpuno isti, s tim {to su teme 
u ovom uputstvu usko vezane za konkretnu aplikaciju. 
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Yu karakteristike 
 
Da bi se ra~unar optimalno koristio, treba ga prilagoditi na{im uslovima 

i standardima. Osnovno je obezbediti ispravno prikazivanje svih na{ih slova na 
ekranu i u izlaznim dokumentima i obezbediti raspored slova na tastaturi koji 
odgovara na{im navikama. Po`eljno je i da prikazivanje datuma, vremena, 
sortiranje podataka i oznaka valuta u finansijskim programima odgovaraju 
na{im standardima.WINDOWS 95 ovo omogu}ava, ali ne za sve zemlje sveta 
u jednom paketu. Postoji vi{e verzije operativnog sistema koje su prilago|ene 
raznim tr`i{tima. Osnovna ameri~ka verzija obezbe|uje podr{ku za 
zapadnoevropske zemlje, Rusiju, Gr~ku i sli~no. Podr{ka za Jugoslaviju se 
nalazi u tzv. panevropskoj verziji paketa koji se nabavlja na poseban zahtev 
pa to treba naglasiti isporu~iocu softvera pri kupovini. 

 
Instalacija fontova 
 
Verzija WINDOWS 95 namenjena ameri~kom tr`i{tu mo`e se prilagoditi 

na{im uslovima, ali tek uz pomo} dodatnih alata doma}ih autora i doinstalacije 
Multilanguage Support modula koji se standardno isporu~uje. Osnovne 
kolekcije slova koje se instaliraju iz ameri~ke verzije paketa ne sadr`e u sebi 
na{a karakteristi~na slova {}|`~. Me|utim, postoje i pro{irene kolekcije istih 
fontova koje se dobijaju instalacijom Multilanguage Support modula. Ako to 
niste uradili u toku instalacije, pokrenite Start->Settings->Control Panel 
sistemske aplikacije i izborom Add/Remove Programs->Windows Setup 
opcije. 

Na listi raspolo`ivih modula WINDOWS 95 treba odabrati Multilanguage 
Support modul i pritiskom na dugme Details pojavi}e se lista raspolo`ivih 
internacionalnih podr{ki. 

Treba odabrati Central European Language Support (kodna strana 
1250) i Cyrilic language support(kodna strana 1251). Ove dve kolekcije u sebi 
ne sadr`e na{u zemlju, ali sadr`e fontove sa na{im latini~nim (CP1250) i 
}irili~nim slovima (CP1251) {to je dovoljno bat za po~etak. 

Izborom tastera OK i jo{ jednom OK doda}e se me|unarodna podr{ka 
za ove zemlje i postoje}i True Type fontovi pro{iriti dodatnim slovima. Ovi 
fontovi su modifikacija postoje}ih i biraju se tokom rada u nekoj aplikaciji preko 
Script opcije ili dodataka u nazivu. Za rad sa latinicom treba odabrati Central 
European (CE) verziju fonta, a za rad sa }irilicom Cyrillic (Cyr). 

 
Pode{avanje tastature 
 
Da bi se na{a slova mogla i otkucati, treba prilagoditi tastaturu, 

odnosno dodeliti YU slova nekim tasterima, uz privremeno isklju~ivanje manje 
va`nih slova iz standardnog rasporeda tastature. 

Iz Control Panel aplikacije se pokrene opcija Keyboard i odabere 
Language panel. Na Language listi bi trebalo da se nalazi standardni 
tastaturni raspored, a novi se dodaje pritiskom na taster Add i izborom opcije 
Slovenian iz padaju}e liste. Na taj na~in dobijaju se dva raspolo`iva rasporeda 
na tastaturi koji se po pootrebi prebacuju odabranom kombinacijom tastera 
(npr. Left Alt+Shift) ili klikom na mali indikator sa skra}enim nazivom zemlje na 
taskbar-u. 
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Ostale nacionalne karakteristike 
 
Pode{avanje ostalih YU karakteristika (format datuma,vremena...) se 

obavlja iz Control Panel-a, preko opcije Regional Settings. Potpuno 
pode{avanje se najlak{e izvodi u panevropskoj verziji WINDOWS 95, tako {to 
se izabere Srbija u kontrolnom panelu. U ameri~koj verziji se mo`e ru~no 
podesiti na~in ispisa za neke od formata koji nam najvi{e odgovara u 
panelima Number (prikaz brojeva), Currency (prikaz nov~anih suma), Time 
(prikaz vremena) i Date(prikaz datuma). Me|utim, ovo re{enje nije ba{ 
savr{eno, jer se recimo ne mogu dobiti nazivi dana u sedmici na na{em jeziku. 

Tako|e ne postoje na{a slova u sistemskim fontovima za ispis menija, 
naziva, terminal prozora i sl. Ovo se mo`e re{iti ubacivanjem *.FON datoteka 
iz neke Windows CEE verzije ili editovanjem postoje}ih. 

 
Explorer 

 
Explorer je osnovna sistemska aplikacija koja slu`i za organizovanje 

podataka na ra~unaru, kopiranje i preme{tanje datoteka i kataloga, osnovni 
pregled sadr`aja, formatiranje disketa, razna pode{avanja perifernih ure|aja i 
uop{te - odr`avanju sistema. Explorer se pokre}e iz Start menija izborom 
opcije Programs, a zatim Explorer. Alternativno, mo`e se pokrenuti i 
dvostrukim klikom na folder na desktopu. 

 
Rad sa datotekama 
 
Explorer se sastoji iz dva panela, gde levi slu`i za hijerarhijski pregled i 

izbor objekata (diskovi, katalozi, mre`ni serveri, svi objekti na desktopu itd.), 
dok se u desnom panelu prikazuje sadr`aj trenutno izabranog objekta 
(katalozi, radne stanice, datoteke, ...). Format sadr`aja prikazivanja se mo`e 
izabrati preko opcije View u meniju. Iz istog menija, opcijom Arange Icons, 
mo`e se izabrati na~in slaganja ikona koji mo`e biti prema nazivu, tipu, veli~ini 
ili datumu poslednje izmene.  

Levi panel je organizovan u obliku stabla prema logi~noj hijerarhiji 
objekata. Ukoliko neka grana na stablu sadr`i “podgrane” koje nisu prikazane, 
pored nje se nalazi mali znak (+). Klikom na plus otvara se slede}i hijerarhijski 
nivo, i znak plus prelazi u minus (-) preko kog se nivo mo`e ponovo sa`eti; isti 
efekti se posti`u i dvostrukim klikom na objekat. Ukoliko prikazano stablo 
postane previ{e razgranato klikom na objekat u levom panelu njegov sadr`aj 
se prikazuje u desnom. 
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Otvaranje objekata 
 
Objekti u desnom panelu “otvaraju” se dvostrukim klikom mi{a. Zavisno 

od tipa objekta, “otvaranje” podrazumeva ulazak u slede}i hijerarhijski nivo 
ukoliko se radi o katalogu, izvr{avanje ukoliko je objekat neki program ili 
u~itavanje u odgovaraju}u aplikaciju ukoliko se radi o nekoj vrsti dokumenata 
ili crte`a. Operativni sistem }e poku{ati da prepozna tip dokumenata na osnovu 
svoje liste, pokrenu}e aplikaciju koja odgovara prepoznatom tipu i u~itati 
dokumenat; isti efekat posti`e se i preko menija.Ukoliko ne prepozna tip 
datoteke, Explorer }e prikazati dijalog za ru~no dodeljivanje doti~nog tipa 
nekoj od instaliranih aplikacija. 

 
Kopiranje i preme{tanje 
 
Kopiranje ili preme{tanje se svodi na prevla~enje objekta (recimo 

datoteke) na neki drugi objekat. Tipi~no se datoteka ili katalog iz desnog 
panela prevu~e na neki disk (npr. A) ili drugi katalog u levom panelu. Za lak{e 
snala`enje mogu se pokrenuti dva Explorer  prozora, tako {to se dvaput 
izabere Explorer,a zatim preme{ta objekt iz jednog u drugi. 

Ukoliko se objekat prevu~e na drugu lokaciju istog diska, on }e biti 
prenesen a ne prekopiran. Preme{tanje podrazumeva kopiranje na novu 
lokaciju i brisanje polaznog objekta na postoje}oj; ako `elite da napravite 
kopiju datoteke, to treba da naglasite tako {to dr`ite pritisnut Ctrl. 

^esto se mi{em uhvati pogre{an objekat i krene u prevla~enje. Ukoliko 
se na pola puta uo~i gre{ka i objekat jednostavno pusti, on }e biti prekopiran ili 
preme[ten na mesto na kome je kursor trenutno, {to mo`e da zbuni po~etnika! 
Prekid operacije treba izvoditi pritiskom na taster Esc. Zbog svega toga je 
preporu~ljivo, da kod ovih operacija preme{tanja i kopiranja koriste desni 
taster mi{a, ~ime }e pre svake operacije biti upitani za potvrdu preko 
posebnog dijaloga. 
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Promena naziva i uklanjanje objekta 
 
Promena naziva objekta (rename) izvodi se klikom na ve} selektovani 

objekat, pritiskom na F2 ili izborom iz menija. Brisanje (ta~nije, preme{tanje u 
Recycle Bin) izvodi se pritiskom na taster Del, klikom desnim tasterom i 
izborom Cut opcije ili iz osnovnog menija. Mogu se brisati datoteke i katalozi, 
a ne i ostali objekti. Pritom se brisanje svodi na preme{tanje objekta u 
specijalni katalog Recycle Bin, gde se ~uvaju dok na disku ima mesta za 
slu~aj da ih treba vratiti nazad. 

 
Pronala`enje datoteka 
  
Jedna od najmo}nijih opcija Explorer-a je pretra`ivanje diskova 

(search). Mogu se tra`iti datoteke i katalozi na lokalnom ra~unaru, ali i na 
ra~unarima unutar mre`e i datoteke na njima. Pretra`ivanje se zadaje 
komandom Tools -> Find i izborom objekta: datoteka ili katalozi, ra~unari u 
mre`i MS Network servis. Najinteresantnije je pronala`enje datoteka.  

U prvom panelu Name & Location zadaje se oblast pretra`ivanja u polju 
Look in. Mo`e se odabrati 
ceo sadr`aj svih diskova u 
ra~unaru ili samo neki od 
njih ili pojedini 
direktorijum sa ili bez 
poddirektorijuma. U polju 
Named mo`e se zadati 
naziv ili bar deo naziva 
datoteke ili kataloga koji 
se tra`i. 

U slede}em panelu 
Date Modified odre|uje se kriterijum pretra`ivanja prema datumu poslednje 
izmene datoteke. Mogu se tra`iti sve datoteke izme|u zadatih datuma, tokom 
prethodnih x meseci ili dana. 

U tre}em panelu se zadaju jo{ neki dodatni kriterijumi, koje ne}emo 
navoditi. 

 
Formatiranje disketa 
 
Izborom objekta tipa disk i klikom na desni taster mi{a dobija se meni iz 

koga se mogu izvesti neke specifi~ne operacije kao {to je formatiranje diskete. 
Format naredbom se dobija dijalog prozor za pode{avanje raznih parametara 
formatiranja. To su kapacitet diskete, brzo brisanje liste sadr`aja ili potpuno 
formatiranje sa proverom ispravnosti cele diskete, kopiranje sistemskih 
podataka na disketu bez formatiranja ili sa formatiranjem ~ime se dobija 
startna boot disketa sa koje se mo`e podi}i sistem. 

Pored disketa mogu se formatirati i particije na disku, osim one koja 
sadr`i sam Windows. 

 
Osobine objekata (Properties) 
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Za svaki objekat mo`e se dobiti lista njegovih osobina bez obzira da li 
je u pitanju datoteka, katalog, disk i dr. Klikne se desnim tasterom mi{a na 
objekat i odabere komanda Properties ili pozove komanda iz menija. 

Dobija se dijalog ~iji sadr`aj zavisi od konkretnog objekta koji je u 
pitanju. Pored navo|enja raznih informacija o datoteci mogu se podesiti njeni 
atributi ili saznati verzija i proizvo|a~. 

 
Priprema slika 
Paint 
 
Program Paint slu`i za pregled slika, jednostavno crtanje, pripremu 

manje slo`enih ilustracija i {ema za dokument, izradi tapeta za radnu povr{inu 
ekrana i sli~no. On radi sa grafi~kim datotekama u BMP, RLE i PCX 
formatima, takozvanim bit mapiranim zapisima slike, zasnovanim na opisu 
boje svake od ta~aka koja sa~injava crte`. Format BMP je standardni format 
direktnog zapisa, RLE format podrazumeva kompresiju pa datoteka zauzima 
manje prostora na disku, dok je PCX standardni format za PC grafiku nastao 
iz programa PC Paintbrush. Paint mo`e da snima BMP format datoteka u 
crno-belom formatu ili u 16, 256 i 16.7 miliona boja. 

Osnovni alati za crtanje se biraju iz “kutije za alat”, pritiskom na 
odgovaraju}e dugme. Naziv alata se dobija tako {to se kursor zadr`i par 
sekundi iznad njega, a kratki opis funkcije se pojavljuje u poslednjem redu 
prozora. Tu su komande za izbor dela slike proizvoljnog ili pravougaonog 
oblika koji se onda mo`e premestiti ili obraditi na drugi na~in,kantica za 
popunjavanje zatvorenih povr{ina, gumica za brisanje dela slike, pipeta za 
izbor neke od postoje}ih boja na crte`u i lupa za uve}anje slike radi preciznije 
obrade. 

Slede alati za crtanje: olovka koja se koristi kao i prava, ~etka za 
izvla~enje debljih linija i “malanje”, prskanje sprejom i upis teksta na sliku, pri 
~emu se pojavljuje dodatni dijalog za izbor tipa i veli~ine slova. Postoje alati 
za crtanje elementarnih geometrijskih figura kao {to su prava i kriva linija, 
pravougaonika, poligona, elipse i krugova uz pritisnut Shift i na kraju 
pravougaonik sa zaobljenim uglovima. 

 
Pode{avanje sistema 

 
WINDOWS 95 je prilagodljiv operativni sistem. To zna~i da se prema 

potrebama i ukusu korisnika mogu podesiti na~ini prikaza, sadr`aji lista 
komandi, nacionalne karakteristike, osobine i performanse priklju~enih ure|aja 
i razne druge opcije. 

 
 
 
 
Komandni panel 
Taskbar 
 
Komandni panel WINDOWS 95 operativnog sistema se inicijalno nalazi 

u dnu ekrana i kao {to je re~eno, slu`i za pokretanje aplikacija, prikaz aktivnih i 
njihovo biranje. 
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Na~in funkcionisanja, polo`aj i veli~ina taskbar-a mo`e se prilagoditi 
potrebama. Komandom Start -> Settings -> Taskbar se dobija dijalog za 
pode{avanje taskbar osobina. Isti dijalog se mo`e dobiti desnim klikom mi{a na 
slobodan deo taskbar-a i izborom opcije Properties iz liste. 

 
Pode{avanje Start menija 
 
Osnovna lista iz koje se pokre}u sve instalirane aplikacije, dobija se 

pritiskom na dugme Start na levom delu taskbar-a. Iz nje se mo`e pokrenuti 
tra`enje neke datoteke, kataloga ra~unara itd.  

Svi ostali instalirani progami se mogu pokrenuti iz Start liste i to na dva 
na~ina: izborom Run opcije i ukucavanjem komande ili izborom iz Programs 
liste instaliranih aplikacija. 

Komanda Run prikazuje dijalog za zadavanje naziva programa ili 
podacima za koje postoji definisana aplikacija kojom se obra|uju. Ukoliko se 
ta~an naziv ne zna dugmetom Browse se mo`e potra`iti konkretna datoteka. 

Za pokretanje instaliranih aplikacija u ra~unaru predvi|en je 
jednostavniji metod - biranjem iz liste Programs mi{em ili kursorskim 
tasterima. Njen sadr`aj se mo`e a`urirati na vi{e na~ina: instalaciona 
procedura operativnog sistema }e tokom ubacivanja novog programa u 
ra~unar automatski dodati i odgovaraju}u stavku u Programs listu. 

 
Control Panel 

 
Pri razvoju WINDOWS 95 posebna pa`nja je posve}ena prilago|avanju 

ukusu korisnika i 
njegovom na~inu 
organizovanja radne 
okoline - mo`e se podesiti 
veliki broj parametara koji 
uti~u na performanse 
pojedinih komponenti 
ra~unarskog sistema. 
Skoro sva pode{avanja 
obavljaju se posredstvom 
sistemske aplikacije 
zvane Control Panel. 

 
Control Panel je 

specijalni objekat u kome 
su koncetrisani sistemski 
programi za 
konfigurisanje. Kada se otvori pojavljuje se prozor ~iji sadr`aj zavisi od 
instaliranih ure|aja, odnosno programskih modula samog WINDOWS 95. 

 
 Datum i veme 
 
Ispod ikone Date/Time krije se program za pode{avanje sistemskog 

datuma i vremena, kao i vremenske zone. Sistemsko vreme koriste svi 
programi, pa je bitno da ono bude ispravno pode{eno. Posebna pa`nja 
“usagla{avanju vremena” posve}uje se vi{ekorisni~kim sistemima i mre`ama. 
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Sama upotreba ove aplikacije je veoma jednostavna: izabere se dan, 
mesec, i godina i u odgovaraju}em polju unese ta~no vreme. Interesantna je i 
mogu}nost pode{avanja vremenske zone koja je va`na ukoliko se {alje 
elektronska po{ta. 

 
Pode{avanje ekrana 
 
Veoma va`an konfiguracioni program bavi se pode{avanjem 

parametara ekrana. Podeljen je u ~etiri “lista” za pode{avanje dezena podloge 
(Background), za{tite ekrana kada se ra~unar ne koristi (Screen saver), 
na~ina prikaza elemenata prozora (Appearance) i izbor grafi~ke rezolucije 
(Settings). 
 

Background 
 
Ako grafi~ki operativni 

sistem poku{ava da simulira 
radni sto, onda mo`emo re}i da 
ova opcija slu`i za izbor 
stolnjaka. Naime, pode{ava se 
izgled pozadine ekrana iznad 
koje se otvaraju prozori 
aplikacija. Pozadina mo`e da 
bude jednobojna, pro`eta 
{rafurom ili sastavljena od 
grafi~kih elemenata poput 
tapeta. Dezeni se biraju iz 
jedne od dve padaju}e liste na kojoj su nabrojane sve mogu}nosti. Tu je i mali 
prikaz ekrana na kome se mo`e proveriti kako }e on izgledati pre nego {to se 
izbor primeni na stvarni ekran. 

 
 
 
 
 
 
 
 
 
 
Screen saver 
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Ova opcija je postala 
popularna poslednjih godina iako u 
su{tini nije neophodna. Naime, ako 
je slika prikazana na ekranu 
uglavnom stati~na, osvetljeni su 
uvek isti delovi ekrana pa se 
ekranski premaz na tim mestima 
vi{e tro{i. Da bi se ekran {tedeo, 
treba ga zatamniti kada se ra~unar 
ne koristi ili bar pustiti neku 
animaciju koja ravnomerno 
optere}uje ekran. Ovo se 
automatizuje tako {to operativni 
sistem prati aktivnosti korisnika i 
ukoliko je on neaktivan tokom 
zadatog perioda, automatski 
uklju~uje odabranu animaciju. Izlazak iz Screen saver moda, tj. “bu|enje” 
ra~unara posti`e se pritiskom bilo kog tastera ili pomeranjem mi{a, posle ~ega 
se vra}a normalni ekran. 

 
Appearance 

 
U ovom panelu se 

pode{ava vizuelni izgled svih 
standardnih grafi~kih elemenata 
WINDOWS 95. To su delovi 
prozora, okviri, naslovi aktivnih i 
neaktivnih aplikacija, ikone, 
meniji, boja pozadine i mnogi 
drugi. Dakle, ono {to se podesi u 
ovom panelu uglavnom defini{e 
izgled svega {to radi pod 
WINDOWS 95.  

 
 
 
 
 
 
 
 
 
 
 
 
Settings 
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Ovo je najva`niji panel Display aplikacije: u njemu se biraju sistemske 
osobine grafi~kog podsistema kao {to su rezolucija, broj boja i sli~no. 
Rezolucija u kojoj radimo defini{e 
“fino}u” prikaza preko broja ta~kica 
od kojih se slika na ekranu sastoji: 
ako se izabere vi{e ta~kica, one }e 
biti sitnije pa }e slika biti finija, ali }e 
rad biti sporiji jer ra~unar mora da 
obra|uje vi{e podataka. 

Izbor rezolucije, dakle, zavisi 
od modela grafi~ke karte i kvaliteta 
monitora. Tipip~no se rezolucija 
pode{ava na 640 ta~aka po 
horizontali i 480 ta~aka po vertikali 
ili 800x600 ta~aka; ove vrednosti 
podr`avaju prakti~no sve danas 
raspolo`ive grafi~ke kartice i 
monitori. 

Drugi bitan kvalitet prikaza je broj boja koje se istovremeno mogu 
prikazati na ekranu, [to opet zavisi od tipa grafi~ke kartice. Svaki model 
omogu}ava rad sa 16 i 256 boja, mada ima kartica sa ve}im brojem boja. 

 
WINDOWS 95 }e tokom instalacije “prepoznati” tip grafi~ke kartice i 

monitora, ali je njegov izbor po`eljno proveriti; po potrebi se u odgovaraju}em 
prozoru pode{avaju precizne vrednosti. Po{to podesite sve {to je potrebno, 
izaberite OK ili odustanite sa Cancel; promena grafi~kog moda ~esto zahteva 
resetovanje ra~unara, na {ta }e vas upozoriti i sama aplikacija. 

 
Pode{avanje mi{a 
 
Preko Mouse ikone pokre}e se sistemska aplikacija za pode{avanje 

pona{anja mi{a, koja se sastoji iz ~etri panela. U prvom, bira se normalan ili 
levoruki polo`aj tastera, ~ime se zamenjuju funkcije levog i desnog tastera 
mi{a. Preko kliza~a se pode{ava dozvoljena brzina dvoklika, vreme koje sme 
da protekne izme|u dva pritiska na levi taster mi{a.  

U Panel Motion panelu pode{avate osetljivost mi{a, odnosno 
koeficijenat koji odre|uje koliko se pomera pokaziva~ na ekranu u odnosu na 
pomeranje mi{a na stolu. 

Panel General slu`i za izbor modela mi{a koji se koristi i eventualnih 
dodatnih opcija koje doti~ni model i njegov drajver podr`avaju: pretvaranje 
pokaziva~a u lupu za zumiranje, fina kontrola polo`aja, prelazak na suprotnu 
ivicu ekrana pri izlasku sa njega i sli~no. 

 
 
 
 
Rad sa fontovima 
 
Font Manager je sistemska aplikacija namenjena pregledu, instalaciji i 

uklanjanju raznih oblika slova (fonts) koji se mogu koristiti pod WINDOWS 95 i 
svim njegovim aplikacijama. 
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Vrste fontova 

 
Osnovni prozor Font Manager-a sadr`i listu trenutno instaliranih fontova 

u obliku malih ili velikih ikona i naziva. Prema ikoni se mo`e prepoznati i tip 
fonta: posebno su zna~ajni True Type fontovi (ikona sa natpisom TT) u kojima 
je svako slovo definisano matemati~kim formulama koje opisuju krive linije 
oblika slova. Druga vrsta fontova su bitmapirani, predstavljeni ikonom sa 
slovom A. Kod njih su sva slova definisana sli~icama, pa se prikazuju bez 
ikakvog prora~unavanja. 

 
Pregled fontova 

 
Font za pregled bira se dvostrukim klikom mi{a na njegovu ikonu, 

dovo|enjem kursora do nje i pritiskom na Enter ili iz menija. Pojavljuje se novi 
prozor u kome su prikazana osnovne karakteristike doti~nog fonta. Najpre je 
dat naziv, preko koga se font referencira u aplikacijama. Sam izgled slova je 
dat u obliku engleskog abecednog niza i brojeva.  

 
 
 
Instalacija fontova 

 
Fontove koje }ete koristiti morate najpre da instalirate tj. uklju~ite u 

operativni sistem posredstvom Font Manager aplikacije. Instalacija se izvodi 
preko File -> Install New Fonts komande u meniju; pojavljuje se dijalog u 
kome treba najpre locirati disk i katalog u kome se nalaze datoteke sa novim 
fontovima. Klikom levog tastera mi{a na `eljeni font on se ozna~ava i pritiskom 
na dugme OK instalira i pojavljuje u listi Font Manager-a. Odjednom mo`e da 
se izabere vi{e fontova koji }e onda biti instalirani u paketu: klik}ete na svaki 
od njih redom dr`e}i pritisnut tasterCtrl.  

Nepotrebni fontovi se uklanjaju tako {to se selektuju i izbere File -> 
Delete komanda iz menija. Treba biti pa`ljiv da se ne ukloni neki od bitnih 
sistemskih fontova bez koji ra~unar ne}e ispravno funkcionisati. 
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Rad sa {tampa~em 
 
Podr{ka {tampa~a je ugra|ena u sam 

operativni sistem WINDOWS 95 koji pru`a 
usluge te vrste svim ostalim aplikacijama. 
To zna~i da se izbor i konfigurisanje 
{tampa~a obavlja odgovaraju}im 
WINDOWS 95 konfiguracionim 
programom, a sve aplikacije zatra`e uslugu 
{tampanja kada je potrebna, bez ikakvih 
dodatnih pode{avanja.  

Kod nekih aplikacija se nudi 
poseban dijalog za pode{avanje opcija (broj 
kopija, {tampanje celog dokumenata ili 
njegovog dela, parnih i neparnih strana i sli~no). Neki slo`eniji programi su 
posebno osetljivi po pitanju kvaliteta {tampanja. Ipak, za najve}i broj primena, 
sva aktivnost oko izbora i pode{avanja {tampa~a obavlja procedurom 
operativnog sistema, koja se pokre}e tokom instalacije WINDOWS 95. 

 
Izbor i instalacija {tampa~a 
 
Komandom Start -> Settings -> Printers dobija se katalog sa listom 

trenutno podr`anih {tampa~a, odnosno njihovih drajvera. Svaki ima svoju 
ikonu na kojoj je eventualno posebnim simbolom nazna~eno da se radi o 
mre`nom {tampa~u (konektor i kabl), {tampanju u datoteku (disketa) i sli~no. 

Ikona Add Printer slu`i za pokretanje sistemske aplikacije koja vodi kroz 
postupak instaliranja podr{ke za novi {tampa~. Procedura je sli~na drugim 
pode{avanjima: pritiska se dugme Next za prelazak na slede}i korak i usput 
bira po neka opcija, a na prethodni dijalog se vra}a sa Back. 

Najpre }e se postaviti pitanje da li instalirani {tampa~ lokalni ili mre`ni. 
Opisa}emo postupak instaliranja lokalnog {tampa~a. 

Sledi klju~ni dijalog - izbor proizvo|a~a i konkretnog modela {tampa~a 
koji je u pitanju. Pogre{an izbor i pode{avanje }e doneti mnoge neo~ekivane 
probleme u radu, {tampanje raznih brljotina, nekontrolisano izbacivanje 
papira, {tampanje samo dela strane i itd. 

Najpre se u levoj listi odabere proizvo|a~, a onda u desnoj neki od 
modela. Ukoliko instalirani model ne postoji na listi, odaberite neki koji ima 
sli~ne karakteristike. Ukoliko se uz {tampa~ dobili diskete sa Windows 
drajverima mo`ete kliknuti na Have Disk i upotrebiti te drajvere umesto 
sistemskih. 

Sledi zadavanje komunikacijskog porta na koji je {tampa~ priklju~en. U 
najve}em broju slu~ajeva koristi se prvi paralelni port (LPT1) koji je namenjen 
{tampa~ima, mada neki modeli mogu koristiti i serijski port. Dugmetom 
Configure Port se eventualno pode{avaju neke osobine porta i na~in njegovog 
tretiranja. Sledi zadavanje imena pod kojim }e se {tampa~ javljati u listi 
raspolo`ivih. 

Pritiskom na dugme Finish dovr{ava se instalacija kopiranjem potrebnih 
veznih programa iz paketa WINDOWS 95 ili aktiviranjem postoje}ih, ukoliko su 
ve} instalirani. 
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Pode{avanje {tampa~a  
 
Parametri {tampa~a i na~in njegovog kori{}enja dobijaju se komandom 

File -> Properties ili desnim klikom mi{a na ikonu {tampa~a i izborom stavke 
Properties iz liste. Ovi parametri zavise od konkretnog modela koji je u pitanju. 
Najva`nije opcije standardnog laserskog printera prikazane su na slici. 

 
Rukovanje papirom 
 
Rezultat {tampanja je ispisan papir. Zato u ovom panelu treba podesiti 

njegove dimenzije (Paper size), jer se umesto Letter formata kod nas naj~e{}e 
koristi A4. Ispis na papir mo`e biti “normalan” (Portrait) ili “po du`ini” 
(Landscape). 

Na~in doturanja papira {tampa~u se zadaje u listi Paper source, a 
mo`e biti ru~ni ili uvla~enjem iz kasete. Ekonomi~ni mod {tampe pri kome se 
{tedi toner ali dobijaju i ne{to ble|e kopije se bira u listi, kao i podrazumevani 
broj kopija. 

 
Odr`avanje diska 

 
Najvrednija stvar na ra~unaru su podaci uneti od strane korisnika; 

uostalom,ra~unari se i nabavljaju da bi se obra|ivali podaci. Podaci se 
memori{u u jedinicama memorije od kojih je, zbog kapaciteta i brzine, 
najzastupljeniji hard disk, mada se koriste i drugi ure|aji (diskete,trake,CD-
ROM itd). 

Odr`avanju hard diska treba strogo posvetiti zna~ajnu pa`nju. Sama 
struktura zapisivanja podataka je prili~no slo`ena i osetljiva na gre{ke koje u 
najve}em broju slu~ajeva nastaju nepropisnim zatvaranjem datoteka sa 
upisanim podacima. Do toga mo`e do}i u slu~aju nestanka struje, resetovanja 
ra~unara, zaglavljivanja aplikacije ili neke gre{ke u njoj. Mogu}i su i problemi u 
samim ure|ajima i njihovim veznim adapterima (kontrolerima), ali kod dobro 
komponovanog i pode{enog sistema problemi tog tipa nisu naro~ito verovatni. 
Ipak, treba preduzeti sve da se oni preduprede a njihove eventualne posledice 
umanje. 

Pogledajmo, dakle, {ta se sve mo`e u~initi upotrebom raspolo`ivih 
WINDOWS 95 sistemskih aplikacija za bezbednost podataka, ispravno i 
efikasno funkcionisanje hard diska. 

 
 
 

Backup 
 

Osnovni postupak za o~uvanje bezbednosti podataka u svim uslovima 
i njihovu za{titu od svih mogu}ih problema posti`e se jedino redovnim 
pravljenjem rezervnih kopija sadr`aja hard diska ili bar datoteka sa unetim 
podacima. Za tu namenu predvi|en je sistemski program Backup koji se 
pokre}e preko Start->Programs->System Tools->Backup. 

Aplikacija se sastoji iz tri osnovna panela za pravljenje kopija (Backup), 
njihovo restauriranje (Restore) i pore|enje sadr`aja originala i kopija 
(Compare).  
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Kopija podataka kreira se u svega par koraka, na panelu Backup. 
Najpre se odaberu diskovi, katalozi i datoteke koje treba prebaciti, sa ekrana 
koji podse}a na Explorer: u levom delu je hijerarhijska lista objekata, a u 
desnom njihov sadr`aj. Selekcija za backup posti`e se klikom mi{a na prazan 
kvadrati} uz objekat, pri ~emu on postaje zatamljen (chek-iran) {to ozna~ava 
da je odabran. 

Kada je izbor na~injen, pritiskom na Next Step prelazite na izbor 
ure|aja za backup. Mo`e se odabrati bilo koji raspolo`ivi ure|aj ili katalog sa 
liste u levom delu, recimo neki drugi hard disk, mre`ni server ili flopi preko 
koga }e se podaci kopirati na diskete. 

To je ujedno i pravi trenutak da se lista datoteka za kopiranje na ciljni 
ure|aj snimi u posebnu konfiguracionu datoteku, File -> Save komandom iz 
menija. Pri slede}em pravljenju buckup-a ne}ete morati ponavljati ~itav 
postupak, ve} }ete sa File -> Open File Set u~itati datoteku. 

Ostaje jo{ da pritisnete Start Backup i procedura po~inje ... potraja}e 
zavisno od koli~ine podataka i brzine prenosa. 

 
Restauracija sa~uvanog sadr`aja 
 
Sa~uvani podaci se, u slu~aju potrebe, mogu vratiti na disk preko 

Restore panela. Sli~an je prethodnom, osim {to treba izabrati lokaciju gde se 
nalazi kopija (obi~no datoteka ima ekstenziju .QIC). U desnom prozoru bi}e 
prikazan njen sadr`aj odakle se mogu odabrati katalozi i datoteke koje se 
vra}aju nazad. 

 
Provera i pore|enje sadr`aja 
 
Tre}i panel Compare slu`i za pore|enje sadr`aja diska i prethodno 

napravljenih backup kopija. U levom delu se odabere ure|aj na kome se nalazi 
kopija. U slede}em koraku (Next) se odabere sadr`aj kopije koji se poredi sa 
originalom na disku i pokrene procedura dugmetom Start Compare. Po 
zavr{etku pore|enja bi}e generisan izve{taj. 

 
Pode{avanje opcija 
 
Pre rada sa backup aplikacijom treba podesitii razne parametre njenog 

pona{anja, {to se obavlja u dijalog prozoru Settings -> Options koji se sastoji 
od ~etri panela. U General panelu se samo uklju~uje zvu~na signalizacija 
toka rada i specificira da li }e novi izve{taj o toku backup procedure prebrisati 
prethodni. Mnogo je interesantniji Backup panel za pode{avanje opcija same 
procedura pravljenja kopija. Pored standardnog kopiranja svih odabranih 
datoteka postoji i inkrementalno ili diferencijalno kopiranje. Izborom ove opcije 
ne kopiraju se sve datoteke na medijum za backup, ve} samo one koje su 
izmenjene u odnosu na prethodno kopirani sadr`aj. 

Restore panel slu`i za odre|ivanje opcija pri vra}anju podataka iz arhive 
na diskove. Najpre u Restore backed up files to treba odabrati da li se podaci 
vra}aju na svoje originalne lokacije, tj. U kataloge iz kojih su snimljeni, na neko 
drugo mesto ili sve u isti katalog. Mo`e se zadati da se samo starije verzije 
automatski zamenjuju, za {ta je bitno da sistemsko vreme ra~unara  uvek 
bude ispravno pode{eno, a mo`e se  i zabraniti bilo kakvo prepisivanje 
postoje}ih disketa. 
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Provera konzistentnosti podataka 

 
Osnovni alat za proveru ispravnosti strukture zapisa podataka na disku 

je sistemska aplikacija Scan Disk; osim pasivne provere, ovaj program }e 
otkloniti ve}inu jednostavnih problema. Nekonzistentnosti u zapisu naj~e{}e 
nastaju neregularnim zavr{etkom rada ra~unara, zbog gre{aka u programima i 
samom operativnom sistemu ili zbog problema i nepode{enosti u samom 
ure|aju. Ovi problemi se manifestuju kao nepropisno zatvorene datoteke ~ija 
se veli~ina ne sla`e sa deklarisanim zauzetim prostorom, neispravan sadr`aj 
kataloga, itd. 

Sve ove probleme 
ScanDisk otkriva i 
popravlja, a uzgred i 
testira ispravnost diska, 
ozna~ava nepouzdane 
delove, restaurira 
o{te}ene podatke i sli~no. 
Zato je po`eljno {to ~e{}e 
ga aktivirati, recimo 
jednom dnevno, pri 
uklju~enju ra~unara. 
ScanDisk se startuje 
preko Startup-
>Programs->SystemTools->ScanDisk. Iako program mo`e da se koristi u 
paraleli sa drugim aplikacijama, preporu~uje se njegovo kori{}enje onda kada 
su ostale aplikacije zatvorene. 
 

Razmena podataka 
 
Operativni sistem WINDOWS 95 u isto vreme mo`e da izvr{ava vi{e 

poslova, {to zna~i da se istovremeno mogu pokrenuti vi{e aplikacija. Jedna od 
njegovih prednosti su {iroke mogu}nosti razmene podataka izme|u tih 
programa: dokumenti ili njihovi delovi mogu da se prenose iz jedne aplikacije 
u drugu na jednostavan na~in i da se pri tome u najve}oj mogu}oj meri o~uva 
njihov sadr`aj, format i osobine. Mo`e se razmenjivati ~ist ali i formatirani 
tekst, slike, tabele i sli~no. 

 
Zajedni~ka oglasna tabla 
Clipboard 
 
Najednostavnija je razmena preko zajedni~ke “oglasne table” koja se 

zove Clipboard. To je u stvari jedan segment memorije (bafer) u koji svaka 
aplikacija mo`e da po{alje podatke ili da iz njega u~ita, ako ih tamo ima. 

Selektujte, recimo deo dokumenta i onda ga komandom Edit -> Copy ili 
Edit -> Cut, prekopirate ili prebacite u Clipboard, odakle se mo`e preneti na 
drugo mesto komandom Edit -> Paste. Po{to Cut, Copy i Paste komande ima 
svaka Windows aplikacija koja radi sa doku mentima i podacima, one su 
uniformno re{ene na nivou operativnog sistema, {to omogu}ava prenos 
podataka izme|u potpuno razli~itih aplikacija. Dovoljno je u jednoj poslati neki 
sadr`aj na Clipboard, pre}i u drugi i u~itati ga. 
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Clipboard u jednom trenutku mo`e da ~uva samo jedan segment 
podataka, pa poslati sadr`aj ostaje na njemu sve dok ne stigne neki novi ili 
dok se Clipboard posebnom komandom ne obri{e. Mo`e se, iz jedne aplikacije 
ne{to upisati a onda to iskoristiti u vi{e drugih programa. 

Ponekad je korisno pregledati {ta se nalazi na Clipboard-u, za {ta je 
obezbe|ena sistemska aplikacija zvana Clipboard Viewer. Pored uvida u 
trenutni sadr`aj Clipboard-a, ovde se omogu}uje snimanje tog sadr`aja u 
posebnu .CLP datoteku, odakle se kasnije mo`e ponovo u~itati u Clipboard. 

 
Kori{}enje DOS programa 

 
DOS radna okolina za WINDOWS 95 predstavlja samo jednu od 

aplikacija koje se trenutno izvr{avaju. Pokre}e se komandom Start -> 
Programs -> MS-DOS Prompt. Pojavljuje se prozor sa komandnom linijom koji 
je prakti~no isti kao radni ekran standardnog DOS-a. 

Ovaj prozor mo`e biti unatar desktop-a ili na celoj povr{ini ekrana uz 
prebacivanje grafi~ke kartice u tekstualni mod, kada je radna okolina jo{ 
sli~nija, a emulacija potpunija. Prelaz izme|u ova dva moda obavlja se 
kombinacijom tastera Alt+Enter. 

Izlazak iz “DOS-a”, odnosno zavr{etak rada njegove emulacije, 
regularno se izvodi kucanjem komande Exit, a u slu~aju potrebe se mo`e 
prekinuti i standardnim komandama za prekid WINDOWS 95 aplikacija. 
Nasilni prekid treba izbegavati, jer DOS programi koji se eventualno izvr{avaju 
ne mogu da prime i obrade poruku operativnog sistema da se rad aplikacije 
zavr{ava, {to mo`e da dovede do gubitka nesnimljenih podataka. 

 
Ra~unarske mre`e 

 
Trend povezivanja personalnih i rugih ra~unara u ra~unarske sisteme 

je prisutan ve} nekoliko godina, a u poslednje vreme se sve vi{e radi i na 
globalnom povezivanju u mre`e na svetskom nivou; najpoznatija globalna 
mre`a zove se Internet. 

Windows 95 sadr`i dora|enu i veoma jednostavnu za upotrebu podr{ku 
u uspostavljanju lokalnih mre`a ra~unara i povezivanje sa razli~itim mre`nim 
sistemim, koja je standardno ugra|ena u osnovni paket operativnog sistema. 

Za razliku od ranijeg koncepta ra~unarskih centara, dana{nja 
tehnologija personalnih ra~unara uvodi koncept distribuiranih sistema. To 
zna~i da svaki korisnik ima kompletan ra~unar sa svim potrebnim resursima. 
Povezivanje u mre`e je u takvoj situaciji neophodno da bi se ostvarila brza i 
automatizovana razmena podataka izme|u pojedinih ra~unara, saradnja na 
zajedni~kim poslovima, kori{}enje zajedni~kih baza podataka i aplikacija ... 
ukratko, obezbedile sve funkcije ra~unarskih sistema, uz brojne prednosti i 
fleksibilnost personalnih ra~unara. 

 
Postavljanje parametara mre`e 
 
Ra~unar ~ije resurse bilo koje vrste mogu i drugi koristiti naziva se 

server. Ra~unar koji mu pristupa da bi se neki resurs koristio naziva se 
klijent ili radna stanica. Windows 95 obezbe|uje da svaki ra~unar mo`e po 
potrebi biti server, klijent ili oboje istovremeno. Korisnik jednog ra~unara mo`e 
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pristupati disku ra~unara nekog drugog korisnika, a da istovremeno tre}i ~lan 
mre`e koristi njegov {tampa~. Sve se odvija transparentno, bez ometanja rada 
njegovih aplikacija.Da bi sve ovo funkcionisalo, svi ra~unari moraju biti fizi~ki 
povezani i moraju biti pode{eni razni organizacioni i komunikacioni parametri. 

 
Organizacija mre`e 
 
Svaki ~lan mre`e (node) mora da ima jedinstveno ime kojim se 

predstavlja (computer name). Ukoliko je u mre`i vi{e desetina ra~unara, treba 
obezbediti i organizaciju, {to se pod Windows 95 re{ava udru`ivanjem 
pojedinih ra~unara u radne grupe prema nekom kriterijumu, a sve grupe 
zajedno ~ine jedinstvenu lokalnu mre`u. Svaki ra~unar po potrebi, mo`e da 
bude ~lan vi{e grupa istovremeno. 

Ovi podaci se unose u panelu Indetification aplikacije za mre`na 
pode{avanja. U polju Computer name treba uneti jedinstveni naziv konkretnog 
ra~unara na osnovu koga }e se on prepoznavati u mre`i, a u polju Workgroup 
naziv grupe kojoj pripada. Najzad, u polju Computer Description se mo`e uneti 
proizvoljni komentar koji }e videti ostali ~lanovi mre`e; on slu`i da pojasni 
lokaciju doti~nog ra~unara, resurse kojima raspola`e ili ne{to sli~no. 

 
 

Zaklju~ak 
 
Microsoft WINDOWS 95 operativni sistem i njegove prate}e aplikacije 

predstavljaju impozantnu kolekciju softvera stvaranu i doterivanu godinama. 
Uz njega ide i mnogo raznih dodataka, specifi~nih opcija i re|e potrebnih alata, 
koje nismo obradili u ovom uputstvu, a tu su i razne “cake” za br`e izvo|enje 
nekih specifi~nih operacija, uz upotrebu modifikatora ~ije bi navo|enje samo 
pove}alo koli~inu informacija koju treba u startu zapamtiti. 

Ukoliko ste sagledali mogu}nosti ra~unara pod WINDOWS 95, ovladali 
osnovnim tehnikama njegovog kori{}enja i sami do{li na neke ideje kako da ga 
iskoriste kao pomo} u svakodnevnim poslovima - postigli smo `eljeni cilj. Puno 
uspeha u radu! 

 


